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Глава  2
АСНОВЫ АНІМАЦЫІ

§ 6. Асноўныя паняцці. Рэдактар для стварэння анімацыі

Самы ранні ўзор анімацыі створа-
ны прыкладна 5000 гадоў назад. Ён 
змешчаны на кубку з неабпаленай 
гліны, знойдзеным у час раскопак у 
Іране. На кубку адлюстравана каза, 
якая падскоквае і зрывае лісты з 
пальмавага дрэва.

Кожны асобны відарыс казы на 
кубку ўяўляе сабой асобны кадр.

У 1877 г. была запатэнтавана вы-
находка француза Шарля-Эміля 
Рэйно  (1844—1918) — праксінаскоп.

Шарль-Эміль 
Рэйно

Праксінаскоп

Праксінаскоп уяўляў сабой ус-
тройства з адкрытага цыліндра, у 
цэнтры якога знаходзілася люстра-
ная прызма. Колькасць граней прыз-
мы адпавядала колькасці відары-
саў-мініяцюр. Пры хуткім вярчэнні 
цыліндра на бачнай грані прызмы 
стваралася ілюзія руху.

6.1. Анімацыя. Віды анімацыі

Чалавек са старажытнасці спраба-
ваў захаваць рух у рысунку. Сёння рух 
відарысаў можна бачыць у мультфіль-
мах, у відэафільмах, у рэкламных ба-
нерах на вэб-старонках і інш. А слова 
анімацыя вядомае нават маленькім 
дзецям. 

Анімацыя (ад лац. animare — 
ажывіць) — працэс змянення паме-
ру, становішча, колеру або формы 
аб’екта з цягам часу.

Анімацыя ўяўляе сабой паслядоў-
ную дэманстрацыю серыі відарысаў 
(кадраў). Кадр адлюстроўваецца нека-
торы час, пасля чаго знікае, а на яго 
месцы з’яўляецца новы.
Кадры — відарысы паслядоўных 

фаз руху аб’ектаў або іх частак.
Анімацыя заснавана на ўласцівасці 

чалавечага зроку «памятаць» відарыс 
на працягу некаторага часу, пасля 
таго як назіранне спыняецца. Чым 
больш кадраў змяшчае анімацыя, тым 
больш згладжаным будзе рух у пра-
цэсе яе прайгравання. Для стварэння 
ілюзіі бесперапыннага руху частата 
змены кадраў павінна быць не меншай 
за 12 кадраў у секунду.

Першапачаткова, пры падрыхтоўцы 
кадраў для анімацыі, кожны кадр ры-
саваўся асобна і цалкам, што аднімала 
шмат часу нават у вялікага калектыва 
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мастакоў. Затым стала выкарыстоў-
вацца паслойная тэхніка рысавання 
аб’ектаў і фонаў на празрыстых плён-
ках, якія накладаюцца адна на адну. 
Гэта знізіла працаёмкасць работ, бо не 
трэба было рысаваць кожны кадр цал-
кам. Сучасныя анімацыйныя тэхна-
логіі пераведзены на камп’ютарную 
аснову.

Камп’ютарная анімацыя — ства-
рэнне анімацыі з дапамогай камп’ю-
тара.

Працуючы над стварэннем кам-
п’ютарнай анімацыі, мастак звычай-
на прамалёўвае пачатковае і канчат-
ковае становішча рухомых аб’ектаў, 
а ўсе прамежкавыя станы разлічвае 
і адлюстроўвае камп’ютар. Аб’екты 
камп’ютарнай анімацыі змяшчаюцца 
на розных слаях (падобна празрыстым 
плёнкам у класічнай анімацыі).

Пры стварэнні камп’ютарнай аніма-
цыі могуць выкарыстоўвацца растра-
выя відарысы (Gif-анімацыя) і вектар-
ныя рысункі (Flash-анімацыя).

Вылучаюць два спосабы стварэння 
камп’ютарнай анімацыі: 

  пакадравая анімацыя;
  разліковая анімацыя — анімацыя 

руху аб’ектаў і анімацыя формы.
Пры стварэнні пакадравай аніма-

цыі прамалёўваюцца ўсе фазы руху 
аб’екта. Такая тэхналогія незаменная 
пры стварэнні складанай анімацыі з 
разнастайнай графікай.
Анімацыя руху або формы праду-

гледжвае маляванне толькі асобных 
кадраў. У гэтых кадрах аб’ект размяшча-
ецца ў пачатку і ў канцы руху. Усе 

Уолт Дзіснэй М. М. Канстанцінаў

Паслойную тэхніку ў мультыплі-
кацыі ўпершыню выкарыстаў Уолт 
Дзіснэй (1901—1966) — амерыканскі 
мастак-мультыплікатар, заснавальнік 
кампаніі Walt Disney Productions.

У 1968 г. група савецкіх вучоных на 
чале з Мікалаем Мікалаевічам Канс-
танцінавым (савецкім і расійскім 
матэматыкам, нар. у 1932 г.) ства-
рыла матэматычную мадэль руху 
жывёліны. Вылічальная машына
БЭСМ-4, выконваючы праграму, пра-
малёўвала кадры мультфільма з ані-
мацыяй рухаў кошкі. Для стварэння 
кінаплёнкі з мультфільмам кожны 
кадр быў раздрукаваны на прынтары, 
ролю пікселя адыгрывала літара «Ш».

У цяперашні час існуюць розныя 
тэхналогіі стварэння камп’ютарнай 
анімацыі. Напрыклад:

  Запіс руху. Акцёры ў спецыяльных 
касцюмах з датчыкамі выконваюць 
рухі, якія запісваюцца камерамі і ана-
лізуюцца спецыяльным праграмным 
забеспячэннем. Выніковыя даныя пра 
перамяшчэнне суставаў і канечнасцей 
акцёраў выкарыстоўваюць у дачыненні 
да двухмерных скелетаў віртуальных 
персанажаў, дзякуючы чаму дасягаюць 
высокага ўзроўню дакладнасці іх руху.

  Працэдурная анімацыя цалкам
або часткова разлічваецца камп’ю-
тарам.

  Пры анімацыі, якая праграміру-
ецца, рухі тых аб’ектаў, што аніміру-
юць, праграміруюцца з дапамогай 
браўзернай мовы JavaScript і мовы ра-
боты з Flash-дадаткамі ActionScript.
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астатнія кадры — прамежкавыя. Ві-
дарыс у іх стварае камп’ютарная пра-
грама, якая вылічае, дзе і ў які момант 
павінен знаходзіцца аб’ект. Разліко-
вая анімацыя выкарыстоўваецца для 
стварэння анімацыйных эфектаў на 
вэб-старонках, а таксама пры стварэнні 
рэкламных, вучэбных і забаўляльных 
фільмаў.

6.2. Рэдактар Flash

З’яўленню камп’ютарнай анімацыі 
спрыяла развіццё праграм для работы 
з графікай.

Праграмы для работы з анімацыяй 
паказаны ў прыкладзе 6.1. Адным з 
найбольш папулярных рэдактараў для 
стварэння анімацыі з’яўляецца Flash. 
Перавага Flash у тым, што з яго да-
памогай можна стварыць прыгожую 
анімацыю, а файлы будуць невялікага 
памеру. Рэдактар Flash мае інтэрфейс, 
шмат элементаў якога знаёмыя вам па 
вопыце работы ў графічных рэдакта-
рах (гл. Дадатак 2, с. 156).

У пачатку работы ў рэдактары неаб-
ходна стварыць новы дакумент (File →
→ New...) або адкрыць той, які ўжо іс-
нуе (File → Open...). 

Дакумент, створаны ў Flash, прыня-
та называць фільмам. У акне рэдакта-
ра Flash можна адначасова адкрываць 
некалькі файлаў з фільмамі. Укладкі 
адкрытых файлаў размяшчаюцца пад 
радком меню: .

Для пераходу да патрэбнага фай-
ла дастаткова пстрыкнуць мышшу па 
ўкладцы з яго імем. Зорачка справа ад 
імя файла абазначае, што ў ім зробле-
ны змяненні, якія не захаваны.

Прыклад 6.1. Для стварэння ані-
міраваных відарысаў існуе мноства 
праграм, як платных, так і бясплат-
ных. Напрыклад:

Vectorian Giotto

Adobe Animate

Easy GIF Animator

Pivot Stickfigure 
Animator

Гісторыя Flash пачалася ў 1996 г.,
калі кампанія Macromedia выпусціла 
прадукт пад назвай Flash. 

У 2005 г. выйшла версія Mac-
romedia Flash Professional 8. У гэтай 
версіі палепшана работа з графікай 
і анімацыяй. У тым жа годзе фірма 
Adobe купіла Macromedia разам з яе 
прадуктамі, уключаючы Flash.

Значкі розных версій рэдактара 
Flash:

Macromedia Flash 
MX 2002

Macromedia Flash 
Professional 8 2005

Adobe Flash 
Professional CC 2015

Для ўстройстваў, якія не пад-
трымліваюць Flash, можна заха-
ваць фільм у фарматах HTML і GIF. 
У гэтым выпадку мультыплікацыя 
можа быць прагледжана практычна 
на ўсіх устройствах.

Рэдактар Flash падтрымлівае мову
сцэнарыяў (апісання паводзін аб’ек-
та) ActionScript. Выкарыстоўваючы 
гэту мову, можна ствараць інтэрак-
тыўныя (якія змяшчаюць элементы 
ўзаемадзеяння з карыстальнікам) 
фільмы.
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У левай частцы акна рэдактара Flash 
размяшчаецца Панэль інструментаў, 
якая складаецца з чатырох частак:

  Инструменты (Tools) — інструмен-
ты рысавання і рэдагавання; 

  Просмотр (View) — спосаб пра-
гляду;

  Цвета (Colors) — колеры абводкі 
і заліўкі;

  Параметры (Options) — настройка 
ўласцівасцей выбранага інструмента.

(Разгледзьце прыклад 6.2.)
У рабочай вобласці рэдактара Flash 

можна выконваць аперацыі стварэн-
ня і рэдагавання аб’ектаў (гл. Дада-
так 2, с. 156). У кадр трапляюць 
толькі тыя аб’екты, якія размешчаны 
ў межах мантажнага стала. Астатняя 
частка рабочай вобласці патрэбна для 
папярэдніх рысункаў і для рэалізацыі 
эфекту паступовага ўваходу аб’екта ў 
кадр (або выхаду з кадра).

Памеры мантажнага стала можна 
змяніць (прыклад 6.3) у акне Свойства 
документа (Document Properties). 

Над рабочай вобласцю знаходзіцца 
шкала времени і список слоев (пры-
клад 6.4). Шкала времени (Timeline) 
прызначана для работы з кадрамі. Слои 
(Layers) — камп’ютарны аналаг праз-
рыстых плёнак, якія выкарыстоўваюц-
ца ў традыцыйнай мультыплікацыі.

У правай частцы акна змяшчаюцца 
дадатковыя панэлі (прыклад 6.5).

Рэдактар Flash падтрымлівае век-
тарную графіку, аднак дазваляе выка-
рыстоўваць і растравыя відарысы, ім-
партаваныя са знешніх файлаў. Пры 
захаванні фільма ў рэдактары Flash 
звычайна выкарыстоўваюць два тыпы 

Прыклад 6.2. Раздзелы Панэлі ін-
струментаў рэдактара Flash.

Прыклад 6.3. Змяненне памераў 
мантажнага стала.

Прыклад 6.4. 

Шкала времени (Timeline)

Список слоев (Layers)
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файлаў: .fla і .swf. Уласным фарма-
там Flash з’яўляецца фармат FLA. У 
гэтым фармаце фільм захоўваецца для 
наступнага рэдагавання. Для рэаліза-
цыі магчымасці прагляду фільма яго 
трэба апублікаваць.
Публікацыя — захаванне фільма 

ў фармаце SWF. Апублікаваць файл 
можна, выканаўшы каманду Файл → 
→ Опубликовать (File → Publish) або 
з дапамогай камбінацыі клавіш Ctrl + 
+ Enter. Файл пры публікацыі захоўва-
ецца ў папку, у якой знаходзіцца файл 
фармату FLA. Апублікаваны фільм 
можна прагледзець у любым прайгра-
вальніку Flash, а таксама ў браўзеры.

Рэдактар Flash дазваляе экспарта-
ваць вынікі работы ў іншыя фарматы. 
Для гэтага неабходна выканаць каман-
ду Файл → Экспорт → Экспорт филь-
ма (File → Export → Export Movie) і 
выбраць фармат файла (прыклад 6.6).

Прыклад 6.5. Дадатковыя панэлі.

1.  Што называюць анімацыяй?
2.  Што ўяўляе сабой кадр?
3.  З якой мінімальнай частатой павінна адбывацца змена кадраў, каб стваралася 
ілюзія бесперапыннага руху?
4.  У чым складаецца пакадравая анімацыя?
5.  Чым разліковая анімацыя адрозніваецца ад пакадравай?
6.  У якім фармаце трэба захаваць фільм, каб яго можна было рэдагаваць?
7.  Што значыць апублікаваць фільм?

Практыкаванні

   Адкрыйце рэдактар Flash. Стварыце новы дакумент. Выкарыстоўваючы матэрыял 
§ 6 і Дадатка 2 (с. 156), вывучыце інтэрфейс акна рэдактара. Выканайце:

1. У меню выберыце Вид → Сетка → Показать сетку (View → Grid → 
→ Show Grid). Як змянілася старонка ў Рабочай вобласці?
2. Устанавіце памеры мантажнага стала .

3. Вывучыце інструменты раздзела Просмотр (View) на Панэлі ін-
струментаў. З дапамогай інструмента Рука (Hand Tool) ( ) пера-
мясціце старонку ў Рабочай вобласці. Павялічце бачны памер старонкі 

?

Прыклад 6.6. Экспарт файлаў.

Смеситель цветов
(Color Mixer)

Библиотека 
(Library)
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і паменшыце яго з дапамогай інструмента  Лупа (Zoom Tool). Настрой-

це павелічэнне (памяншэнне) маштабу ў раздзеле Параметры ( ).

4.  Адкрыйце (закрыйце) дадатковыя вокны Смеситель Цветов (Color 
Mixer) і Библиотека (Library).

   Адкрыйце ў рэдактары Flash файл. Захавайце файл пад новым імем. Выканайце 
публікацыю фільма. Прагледзьце фільм у прайгравальніку Flash.

§ 7. Стварэнне відарысаў і рэдагаванне аб’ектаў

Прыклад 7.1. Рысаванне ліній.

        
Перад рысаваннем лініі на Панэлі 

ўласцівасцей выбраць:

1.  Таўшчыню: 
2.  Колер: 

7.1. Стварэнне відарысаў

Асноўным аб’ектам, які аніміруецца 
ў рэдактары Flash, з’яўляецца вектар-
ны відарыс. Стварэнне вектарных ві-
дарысаў у Flash мае шмат агульнага 
з аналагічным працэсам у вектарных 
рэдактарах. Разгледзім асаблівасці 
выкарыстання інструментаў рысаван-
ня рэдактара Flash.

Для рысавання ліній у рэдактары 
Flash выкарыстоўваецца інструмент  
Линия (Line). Вызначыць колер, стыль 
і таўшчыню можна на Панэлі ўла-
сцівасцей (прыклад 7.1). Лініі з вуглом 
нахілу, кратным 45°, рысуюцца пры 
націснутай клавішы Shift. 

Авал можна нарысаваць з дапамо-
гай інструмента  Овал (Oval). Гэты 
інструмент таксама выкарыстоўваец-
ца для рысавання круга і акружнасці 
(пры націснутай клавішы Shift).

Для рысавання прамавугольнікаў вы-

карыстоўваюць інструмент  Прямо-
угольник (Rectangle). Каб задаць радыус 
закруглення вуглоў прамавугольніка, 
трэба на Панэлі інструментаў у раздзе-
ле Параметры выбраць  і ў дыяло-
гавым акне Настройки прямоугольни-
ка (Rectangle Settings) увесці значэн-
не радыуса ў пікселях (прыклад 7.2).

3.  Стыль:

Прыклад 7.2. Рысаванне прамаву-
гольніка з закругленымі вугламі.

Прыклад 7.3. Дыялогавае акно 
Tool Settings.
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Для рысавання многавугольнікаў 
і зорак трэба выбраць інструмент  
Многоугольник/Звезда (PolyStar), раз-
гарнуўшы спіс інструмента :

Калі інструмент  актыўны, на 
Панэлі ўласцівасцей знаходзіцца 
кнопка , якая выклікае акно 
настройкі інструмента (прыклад 7.3). У 
ім можна выбраць тып фігуры (многа-
вугольнік/зорка), задаць колькасць ста-
рон (прамянёў) і іх памер (прыклад 7.4).

Для рысавання ліній і крывых 
выкарыстоўваецца інструмент  Перо 
(Pen) (прыклад 7.5). З дапамогай гэтага 
інструмента лёгка рысаваць ломаную 
лінію. Пстрычкамі мышы рысуецца 
адрэзак або контур, які складаецца з 
адрэзкаў прамых ліній, злучаных ву-
главымі (апорнымі) пунктамі.

Для рысавання контураў адвольнай 
формы выкарыстоўваецца інструмент 

 Карандаш (Pencil). Для інструмен-
та Карандаш можна выбраць розныя 
рэжымы рысавання (прыклад 7.6):

  Выпрямление (Straighten) дазваляе 
пераўтварыць зыходны відарыс у адну 
з геаметрычных фігур (прыклад 7.7);

  Сглаживание (Smooth) згладжвае 
лініі. Ступень згладжвання ліній за-
даецца на Панэлі ўласцівасцей у полі 

;
  Рисунок чернилами (Ink) падобны 

да рэжыму Smooth. Ступень згладж-
вання нязначная і не змяняецца.

Прыклад 7.4. Рысаванне многаву-
гольнікаў і зорак.

Прыклад 7.5. Рысаванне ломанай 
лініі інструментам Перо.

Прыклад 7.6. Выбар рэжыму ры-
савання для інструмента Карандаш.

Прыклад 7.7. Выкарыстанне ін-
струмента Карандаш у рэжыме Вы-
прямление.

У час 
рысавання

Пасля завяршэння 
рысавання
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 7.2. Рэдагаванне відарысаў

Пры падрыхтоўцы кадраў аніма-
цыі даводзіцца рэдагаваць існуючыя 
аб’екты. Уласцівасці абводкі і заліўкі 
(колер, форма, узаемнае размяшчэнне) 
могуць змяняцца карыстальнікам не-
залежна адна ад адной. Заліўку і аб-
водку можна выдаляць паасобку.

Перш чым выканаць якія-небудзь 
дзеянні з аб’ектам, яго неабходна вы-
лучыць. Рэдактар Flash валодае вя-
лікім спектрам інструментаў вылучэн-
ня (прыклад 7.8). Асноўны інструмент 

вылучэння —  Выбор (Selection). З 

яго дапамогай можна вылучыць увесь 
аб’ект, склаўшы яго ў прамавугольнік. 
Той жа вынік атрымаецца, калі вы-
канаць двайную пстрычку па аб’екце. 
Некалькі аб’ектаў вылучаюцца пры 
націснутай клавішы Shift. Вылучаны 
аб’ект пакрываецца дробнай сеткай. 
Пстрычкай можна вылучаць заліўку 
або абводку паасобку (прыклад 7.9).

З дапамогай інструмента  можна 

выконваць наступныя аперацыі рэда-
гавання аб’ектаў:

  Перамяшчэнне. Вылучыць аб’ект. 
Пры з’яўленні крыжыка з двунакіра-
ваных стрэлак перамясціць аб’ект.

  Змяненне становішча вяршынь. 
Падвесці курсор да вяршыні і пера-
мясціць вяршыню.

  Змяненне контуру. Не вылучаючы 
контур, падвесці курсор да контуру і 
перамясціць у патрэбным напрамку.

(Разгледзьце прыклад 7.10.)
Шмат якія аперацыі змянення 

аб’ектаў могуць быць выкананы з да-

памогай інструмента  Произволь-

Прыклад 7.8. Інструменты вы-
лучэння:

  —  Выбор (Selection);

  —  Выбор подобласти (Subse-
lection);

  —  Петля (Lasso); 

  —  Произвольная трансформа-
ция (Free Transform);

  —  Перо (Pen Tool).

Прыклад 7.9. Вылучэнне аб’ектаў.

Увесь аб'ект Заліўка

Частка абводкі
Усе часткі 

абводкі (с Shift)

Прыклад 7.10. Выкарыстанне ін-
струмента .

                 
Перамяшчэнне

Змяненне становішча вяршынь

Змяненне контуру
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ная трансформация (Free Transform). 

Пры рабоце з інструментам  пасля 

вылучэння аб’екта на Панэлі інстру-
ментаў становяцца даступнымі кнопкі 
выбару рэжымаў: 

  Поворот и наклон (Rotate and 
Skew);

  Масштабирование (Scale);
  Искажение (Distort);
  Изгиб (Envelope).

(Разгледзьце прыклад 7.11.)
Прыклад 7.12 ілюструе змянен-

не аб’екта пры выкарыстанні інстру-
мента Произвольная трансформация 
ў розных рэжымах. Трансфармацыя 
выконваецца з дапамогай маркераў, 
размешчаных на вылучальнай рамцы. 
Кожны маркер злучаны з пэўнай апе-
рацыяй. Розным маркерам адпавядае 
свой варыянт паказальніка мышы.

З дапамогай каманд меню Изме-
нить (Modify) можна выканаць апера-
цыі над аб’ектамі:

  Пераўтварэнне (змяненне паме-
ру, паварот, адлюстраванне і інш.) — 
Трансформация (Transform);

  Групоўку (аб’яднанне некалькіх 
аб’ектаў у адзін) — Группировка 
(Group);

  Выраўноўванне (па гарызанталі 
і па вертыкалі, адносна меж аб’ектаў 
і адносна цэнтра) — Выравнивание  
(Align).

Прыклад 7.11. Кнопкі выбару 
рэжыму для інструмента Произволь-
ная трансформация.

Зыходны відарыс

                 
                         Паварот                                   Нахіл    

                                             
  Маштабаванне                             Скажэнне

Выгін

Прыклад 7.12. Выкарыстанне ін-
струмента Произвольная трансфор-
мация.

Options

1.  Якія інструменты рэдактара Flash выкарыстоўваюцца для рысавання?
2.  У якім рэжыме інструмента Карандаш рысуюцца геаметрычныя фігуры?
3.  Для чаго прызначаны інструмент Выбор?
4.  Якія пераўтварэнні аб’екта можна выканаць з дапамогай інструмента Произ-
вольная трансформация?

?
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      Практыкаванні

  Адкрыйце файл. Дапоўніце відарыс аўтамабіля. Пры ры-
саванні акна выкарыстоўвайце градыентную заліўку. Ска-
піруйце відарыс акна, выкарыстайце ў дачыненні да копіі апе-
рацыю адлюстравання. Захавайце змяненні ў файле.

   Стварыце відарысы, выкарыстоўваючы рэкамендацыі.

Відарысы Рэкамендацыі

Выкарыстоўвайце інструменты  і  з настройкамі:

Выкарыстайце інструмент  для пераўтварэння ліній 

у дугі або нарысуйце дугі як частку акружнасці.

Для рысавання выкарыстоўвайце інструменты  і

. Інструмент  выкарыстоўвайце ў розных рэжы-

мах. Карэкціруйце відарыс з дапамогай інструмента 

.

Капіраванне акон выконвайце, утрымліваючы клавішу 
Shift.
Для выгіну дома выкарыстоўвайце інструмент  .

Скарэкціруйце контур з дапамогай інструмента .

Захавайце відарысы ў фармаце FLA.

   Нарысуйце аднаго з робатаў. Для рысавання выкарыстоўвайце інструменты , , 

 і інструмент рэдагавання . Захавайце відарыс з імем, якое адпавядае эмоцыі 
робата.
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